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¡WELCOME TO typescript!

TypeScript is a typed superset of JavaScript that compiles to plain JavaScript. It is a powerful tool that can help you write more robust, maintainable, and scalable JavaScript code.

This book is a comprehensive guide to TypeScript. It covers everything you need to know to get started with TypeScript, including:


	The basics of TypeScript syntax and semantics

	Type systems and type inference

	Classes, interfaces, and modules

	Advanced features such as generics, decorators, and async/await



This book is written for developers of all levels of experience. Whether you are a beginner or an experienced JavaScript developer, this book will help you learn TypeScript and use it to write better JavaScript code.

Audience

This book is for developers of all levels of experience who want to learn TypeScript.

Prerequisites

This book assumes that you have a basic understanding of JavaScript.

What you will learn

By the end of this book, you will be able to:


	Write TypeScript code that is type-safe and easy to maintain

	Use TypeScript features such as classes, interfaces, and modules

	Compile TypeScript code to plain JavaScript



How to use this book

This book is designed to be read from start to finish. However, you can also use it as a reference for specific topics.

Conclusion

This book is a comprehensive guide to TypeScript. It is a valuable resource for developers who want to learn TypeScript and use it to write better JavaScript code.

¡Go!
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1. Setting the Stage
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1.1 Brief History of TypeScript
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TypeScript is a typed superset of JavaScript that compiles to JavaScript. It was developed by Anders Hejlsberg, the creator of C#, and Microsoft. TypeScript was first released in 2012, and it has since become a popular language for developing web applications, server-side applications, and mobile applications.

Early days

The idea for TypeScript came about in 2010, when Anders Hejlsberg was working on a project to create a new programming language for the web. Hejlsberg was frustrated with the lack of type safety in JavaScript, which made it difficult to write robust and maintainable code. He believed that a typed language would make it easier for developers to write safer and more efficient code.

Hejlsberg and his team began working on TypeScript in 2011. The first public release of TypeScript was in 2012. TypeScript 1.0 was a very basic language, but it had the core features that make TypeScript a powerful tool for developing web applications.

Growth and adoption

TypeScript quickly gained popularity among developers. In 2014, Microsoft released TypeScript 2.0, which added a number of new features, including modules, generics, and decorators. These features made TypeScript an even more powerful and versatile language.

TypeScript's popularity continued to grow in the years that followed. In 2016, TypeScript 2.2 was released, which added support for async/await and class properties. In 2017, TypeScript 2.7 was released, which added support for namespaces and top-level await.

Today

TypeScript is now a widely adopted language for developing web applications, server-side applications, and mobile applications. It is used by companies such as Google, Microsoft, and Amazon.

Contributions to the JavaScript community

TypeScript has made a number of significant contributions to the JavaScript community. It has helped to improve the type safety of JavaScript, which has made it easier for developers to write safer and more efficient code. TypeScript has also helped to promote the use of object-oriented programming in JavaScript.

Conclusion

TypeScript is a powerful and versatile language that is quickly becoming the standard for developing web applications, server-side applications, and mobile applications. It is a great choice for developers who want to write safer, more efficient, and more maintainable code.

––––––––
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Additional details

In addition to the general history of TypeScript, there are a number of specific details that are worth mentioning.

TypeScript is a superset of JavaScript, which means that any valid JavaScript code is also valid TypeScript code. However, TypeScript adds a number of features that are not available in JavaScript, such as type safety, modules, and generics.

TypeScript is compiled to JavaScript, which means that it can be run on any platform that supports JavaScript. This makes TypeScript a very versatile language that can be used to develop applications for a wide range of devices.

TypeScript is an open-source language, which means that it is free to use and modify. This has helped to drive the growth of the TypeScript community and has led to the development of a number of tools and resources that make it easy to learn and use TypeScript.

Examples

Here are some examples of how TypeScript can be used to improve the type safety of JavaScript code:

// JavaScript

function add(x, y) {

return x + y;

}

add("a", 1); // TypeError: "a" is not a number

// TypeScript

function add(x: number, y: number): number {

return x + y;

}

add("a", 1); // Error: Type 'string' is not assignable to type 'number'

In the JavaScript example, the function add() takes two parameters, x and y. However, the function does not specify the types of x and y. This means that the function could be called with any type of value, including strings, numbers, or objects.

In the TypeScript example, the function add() is more type-safe. The function specifies that x and y must be numbers. This means that the function can only be called with numbers. If the function is called with a string or an object, an error will be thrown.

Here is a table that summarizes the key features of TypeScript:



	Feature

	Description




	Type safety

	TypeScript adds type safety to JavaScript, which helps to prevent errors and make code more maintainable.
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1.2. Why TypeScript?

TypeScript is a typed superset of JavaScript that compiles to JavaScript. It was developed by Anders Hejlsberg, the creator of C#, and Microsoft. TypeScript was first released in 2012, and it has since become a popular language for developing web applications, server-side applications, and mobile applications.

There are many reasons why developers choose to use TypeScript. Here are some of the most common reasons:

Type safety

TypeScript adds type safety to JavaScript, which helps to prevent errors and make code more maintainable. In JavaScript, variables can be assigned any type of value, even if that value is not compatible with the variable's type. This can lead to errors that are difficult to debug. TypeScript, on the other hand, requires variables to be assigned values of the correct type. This helps to prevent errors and makes code more maintainable.

Examples:

// JavaScript

function add(x, y) {

return x + y;

}

add("a", 1); // TypeError: "a" is not a number

// TypeScript

function add(x: number, y: number): number {

return x + y;

}

add("a", 1); // Error: Type 'string' is not assignable to type 'number'

In the JavaScript example, the function add() takes two parameters, x and y. However, the function does not specify the types of x and y. This means that the function could be called with any type of value, including strings, numbers, or objects.

In the TypeScript example, the function add() is more type-safe. The function specifies that x and y must be numbers. This means that the function can only be called with numbers. If the function is called with a string or an object, an error will be thrown.

––––––––
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Modules

TypeScript supports modules, which help to organize code and make it easier to reuse. In JavaScript, code is typically organized into files. However, there is no way to import code from one file into another. This can make it difficult to organize code and reuse it in different projects. TypeScript, on the other hand, supports modules. Modules allow developers to import code from one file into another. This makes it easier to organize code and reuse it in different projects.

Examples:

// JavaScript

// file: app.js

function add(x, y) {

return x + y;

}

// file: main.js

import { add } from "./app";

console.log(add(1, 2)); // 3

// TypeScript

// file: app.ts

function add(x: number, y: number): number {

return x + y;

}

// file: main.ts

import { add } from "./app";

console.log(add(1, 2)); // 3

In the JavaScript example, the function add() is defined in the file app.js. The function is then imported into the file main.js. The function add() can then be called from the file main.js.

In the TypeScript example, the function add() is defined in the file app.ts. The function is then imported into the file main.ts. The function add() can then be called from the file main.ts.

Object-oriented programming

TypeScript supports object-oriented programming (OOP), which makes it easier to write complex applications. In JavaScript, OOP is supported through the use of classes and objects. However, JavaScript's OOP support is not as robust as the OOP support in other languages. TypeScript, on the other hand, provides robust OOP support. This makes it easier to write complex applications in TypeScript.

Examples:

// JavaScript

class Person {

constructor(name, age) {

this.name = name;

this.age = age;

}

sayHello() {

console.log(`Hello, my name is ${this.name}`);

}

}

const person = new Person("John Doe", 30);

person.sayHello(); // Hello, my name is John Doe

// TypeScript

class Person {

constructor(public name: string, public age: number) {

}

sayHello() {

console.log(`Hello, my name is ${this.name}`)

}

}
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1.3. Setting Up Your Development Environment
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Before you can start writing TypeScript code, you need to set up your development environment. This involves installing TypeScript and a TypeScript compiler, as well as an IDE or text editor that supports TypeScript.

Installing TypeScript

The easiest way to install TypeScript is to use the TypeScript package manager, npm. To install TypeScript, open a command prompt or terminal and run the following command:

npm install -g typescript

This will install the TypeScript compiler globally on your system.

Installing a TypeScript compiler

If you prefer not to use the TypeScript package manager, you can also install a TypeScript compiler manually. To do this, download the TypeScript compiler from the TypeScript website.

Installing an IDE or text editor

There are a number of IDEs and text editors that support TypeScript. Some popular options include:


	Visual Studio Code

	IntelliJ IDEA

	Sublime Text

	Atom



Configuring your IDE or text editor

Once you have installed an IDE or text editor, you need to configure it to support TypeScript. This typically involves installing a TypeScript extension or plugin.

Visual Studio Code

To configure Visual Studio Code to support TypeScript, install the TypeScript extension. You can do this by opening Visual Studio Code and going to the Extensions tab. Search for "TypeScript" and install the extension from Microsoft.

IntelliJ IDEA

To configure IntelliJ IDEA to support TypeScript, go to File > Settings > Languages & Frameworks > TypeScript. In the TypeScript Compiler section, select the TypeScript compiler that you installed.

Sublime Text

To configure Sublime Text to support TypeScript, install the TypeScript plugin. You can do this by going to Package Control: Install Package. Search for "TypeScript" and install the plugin from Sublime Text Package Control.

Atom

To configure Atom to support TypeScript, install the TypeScript plugin. You can do this by opening Atom and going to Preferences > Packages. Search for "TypeScript" and install the plugin from Atom Package Manager.

Once you have installed TypeScript and configured your IDE or text editor, you are ready to start writing TypeScript code.

Additional details

In addition to the general steps outlined above, there are a few additional details that you may want to consider when setting up your development environment for TypeScript.

Node.js

TypeScript requires Node.js to be installed. Node.js is a JavaScript runtime environment that provides a number of features that are useful for TypeScript development, such as the ability to run TypeScript code in a browser.

TypeScript declaration files

TypeScript declaration files (.d.ts files) provide type information for TypeScript code that is written in other languages, such as JavaScript. To use TypeScript declaration files, you need to install the TypeScript declaration files for the libraries and frameworks that you are using.

Linters and formatters

Linters and formatters can help you to improve the quality of your TypeScript code. There are a number of linters and formatters available for TypeScript, such as ESLint and Prettier.

Examples

Here is an example of how to install TypeScript and configure Visual Studio Code to support TypeScript:

Open a command prompt or terminal and run the following command to install TypeScript globally:

npm install -g typescript


	Open Visual Studio Code.

	Go to the Extensions tab.

	Search for "TypeScript" and install the extension from Microsoft.



Here is a table that summarizes the steps involved in setting up your development environment for TypeScript:



	Step

	Action




	1

	Install TypeScript




	2

	Install a TypeScript compiler




	3

	Install an IDE or text editor




	4

	Configure your IDE or text editor





Here is an image of the TypeScript extension in Visual Studio Code:

code.visualstudio.com

Conclusion

Setting up your development environment for TypeScript is a relatively straightforward process. By following the steps outlined in this section, you can be up and running in no time.
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2. TypeScript Fundamentals Revisited
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2.1. Basic Types and Type Inference
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TypeScript is a typed language, which means that variables and expressions have a specific type. This helps to prevent errors and make code more maintainable.

Basic types

TypeScript has a number of basic types, including:


	Numbers

	Strings

	Booleans

	Arrays

	Objects

	Enums

	Null

	Undefined



Numbers

Numbers in TypeScript can be either integers or floating-point numbers. Integers are whole numbers, such as 1, 2, 3, and so on. Floating-point numbers are numbers with a decimal point, such as 1.0, 2.5, and so on.

Strings

Strings in TypeScript are sequences of characters. Strings can be enclosed in single quotes (') or double quotes (").

Booleans

Booleans in TypeScript can have two values: true or false.

Arrays

Arrays in TypeScript are collections of elements. Arrays can be of any type, including numbers, strings, objects, and so on.

Objects

Objects in TypeScript are collections of key-value pairs. Objects can be used to represent data structures, such as people, products, and so on.

Enums

Enums in TypeScript are a way to represent a set of named constants. Enums can be used to improve the readability and maintainability of code.

Null

The null type represents a value that is undefined or null.

Undefined

The undefined type represents a value that has not been initialized.

Type inference

TypeScript uses type inference to automatically determine the type of a variable or expression. In most cases, TypeScript can correctly infer the type of a variable or expression based on the value that is assigned to it.

Examples

Here are some examples of basic types and type inference in TypeScript:

// Number

let number: number = 1;

// String

let string: string = "Hello, world!";

// Boolean

let boolean: boolean = true;

// Array

let array: number[] = [1, 2, 3];

// Object

let object: { name: string; age: number } = { name: "John Doe", age: 30 };

// Enum

enum Color {

Red,

Green,

Blue

}

let color: Color = Color.Red;

// Null

let nullValue: null = null;

// Undefined

let undefinedValue: undefined = undefined;

Here is a table that summarizes the basic types in TypeScript:



	Type

	Description




	number

	Integer or floating-point number




	string

	Sequence of characters




	boolean

	True or false




	Array

	Collection of elements




	Object

	Collection of key-value pairs




	Enum

	Named constants




	null

	Undefined or null value




	undefined

	Uninitialized value





Conclusion

Basic types and type inference are essential concepts in TypeScript. By understanding these concepts, you can write more concise and maintainable code.
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2.2. Interfaces and Classes
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TypeScript supports two main types of data structures: interfaces and classes. Interfaces and classes are used to define the structure and behavior of data.

Interfaces

Interfaces are a way to define the behavior of a data structure. Interfaces do not have any implementation; they only define the properties and methods that a data structure must have.

Classes

Classes are a way to define the structure and behavior of a data structure. Classes have both properties and methods, and they can also inherit from other classes.

Interfaces

Interfaces are defined using the interface keyword. The interface keyword is followed by the name of the interface and a list of properties and methods.
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